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Introduction

Compact camera modules are widely used in electronic devices such as mobile phones and
tablet computers. In order to reduce both the size and number of elements required the
optical design will typically incorporate several highlylaspheric surfaces. This model

demonstrates a five element (plus filter) design using the 'Aspheric Even Lens 3D' part
from the Ray Optics Module part library.

Model Definition

An overview of the optical design of the compact camera module used in this tutorial is
shown in Figure 1. The prescription for this lens design can be found in Ref. 1. It has a
7.0 mm focal length, a //2.4/focal ratio, and a nominal field of view of 36°.
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Figure 1: Overview of the Compact Camera Module optical design. In this cross-section view,
the rawys have been colored by release index.

The detailed optical prescription is given in Table 1. Instructions for creating the lens
geometry sequence (Figure 2) can be found in the Appendix — Geometry Instructions.
In addition to the parameters used to define the Compact Camera Module geometry, a set

of parameters are required to define the ray tracing model. These are listed in Table 2.
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The smaller the f/number, the lower the magnification, the wider the field, and the brighter the image with any given eyepiece or camera.


TABLE I: COMPACT CAMERA MODULE OPTICAL PRESCRIPTION.

Index Name Radius Conic Thickness Refractive = Diameter
(mm) constant (mm) index (mm)

0 Object 0 — 0 — —

| Stop 0 — 0.0000 — 2.50

2 Lens | 1.679 0.22669364 1.1080 1.544 2.90
Aspheric A, =9.80281-107, A, = -3.81227-10°2, Ag = 2.39681-102,
coefficients:  Ajg=-6.29128:103, A, = -2.75496:10°3, A4 = -2.69638:10°*

3 -9.162 0 0.1000 — 3.05
Aspheric A, =3.73187-10% Ay = -8.917601073, Ag = -5.89384-1072,
coefficients: Ao = 441115102 A, =-1.26858 102, A 4 = 1.16125-1073

4 Lens 2 -15.649 0 0.2300 1.632 2.70
Aspheric Ay = 693172102 Ag = -4.31157-10°2, Ag = 2.33346e° 1072,
coefficients:  Ajg=-2.33074102, A, = 2.22119-102, A, = -4.84076-10

5 3.482 8.70133393 1.1305 — 2.21
Aspheric A4 =521579-107, Ay = 7.15829-1072, Ag = -4.60926:102,
coefficients: Al0 = 1.24310-102, A, = 3.32216e°10°

6 Lens 3 -12.801 0 0.2300 1.632 2.30
Aspheric A4 =3.96000-1072, Ay = -3.42179-10°2, Ag = 7.75523-102,
coefficients: Ao = -4.22361-102

7 21.119 0 1.0559 — 2.25
Aspheric Ay= 101117107, Ag=-321118102, Ag = 9.03668 102,
coefficients: Ao =-3.37156:102, A, = -6.52751-103

8 Lens 4 -3.266 0.85965815 0.2300 1.544 2.95
Aspheric A4 =-4.91398102, A, = -5.57533-103, Ag = 1.31557-1072,
coefficients: Ao = 1.22280-103, A, = -9.54019-10%, A, = -2.40349-10°¢

9 2.724 0 0.1000 — 3.75
Aspheric A, =-8.88955-102, A, = 287927102, Ag = -8.83436-1073,
coefficients: Ao = 1.57329-10°3, A, = -2.24134-10*

10 Lens 5 5.272 0 1.0356 1.632 3.90
Aspheric A4 =-238313-102, A, = 5503211073, Ag = -9.19080-10%,
coefficients: Ao = -9.80631-10°

I -4.681 3.15790955 0.1337 — 4.00
Aspheric A, =-3.17139-102, A, = 3.80781-1073, Ag = 3.43810-10,
coefficients: Ao = -3.27888-10"

12 IR Filter 0 0 0.2100 1.516 4.50

13 0 0 0.1363 — 4.50

14 Image Plane o 0 — — 5.00

3 | COMPACT CAMERA MODULE



mm

mm 0

mm

Figure 2: The Compact Camera Module geometry sequence. Instructions for creating the lens
geometry can be found in the Appendix.

TABLE 2: COMPACT CAMERA MODULE MODEL DEFINITIONS.

Parameter Value Description

Avac 587.56 nm Vacuum wavelength

Tref 1 1.544 Lens | and 4 refractive index (at 587.56 nm)
Nref,2 1.632 Lens 2, 3, and 5 refractive index (at 587.56 nm)
Tyef 3 1.516 IR filter refractive index (at 587.56 nm)
Dypit 2.50 mm Entrance pupil diameter

Niing 25 Number of hexapolar rings. (Nyqys = 1951)
04 0° Field angle |

09 5° Field angle 2

03 10° Field angle 3

04 I5° Field angle 4

Az -0.5 mm Ray release z-coordinate
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“The ray tracing algorithm used by the Geometrical Optics interface computes the refracted
ray direction based on a discretized geometry via the underlying finite clement mesh. In
this model, a cubic geometry shape order is used in order to reduce the discretization
error. However, it is sometimes necessary to refine the mesh on certain surfaces in order
to further reduce the effects of discretization. The aspheric surfaces of the Compact

Camera Module have been assigned to a cumulative selection (Figure 3) on which the
mesh has been refined (Figure 4).!

The Compact Camera Module is assumed to be operating in air at room temperature. The
wavelength is set to A = 587.56 nm (that is, the wavelength at which the refractive indices
are specified). Other Geometrical Optics features include the use of cumulative selections
to define obstructions (see Figure 5) and the focal surface./A hexapolar grid release is used
(1951 rays per field angle. Detailed instructions for creating this model can be found in

Modeling Instructions.

mm 0
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I——»z

Figure 3: The Compact Camera Module aspheric surface cumulative selection.

1. This level of mesh refinement is only needed for certain surface types. The default physics-controlled mesh is

often suitable for single physics ray tracing studies when using the high-accuracy surfaces used in the spherical and
conic lens and mirror parts from the Ray Optics Module Part Libraries.
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Figure 4: The Compact Camera Module mesh. This view shows the aspheric surfaces on which
the mesh has been refined.
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Figure 5: The Compact Camera Module obstruction cumulative selection.
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Results and Discussion

The ray trace of the Compact Camera Module is shown in Figure 6. The lens geometry
has been rendered using component selections and Cut Plane datasets. In this figure the
rays have been colored according to the radial distance from the centroid of each release
at the image plane. It can be seen that the outermost ring of rays contribute most
significantly to the rays aberrations.

The spot diagram for this ray tracing study can be seen in Figure 7. In this figure the rays
are colored according to their relative radial location at the stop! This also makes the origin
of the most aberrant rays apparent.

Time=3.3356E-11 sRay trajectories Surface: abs(y) (mm) Surface: abs(x) (mm) Surface: (1)

pum

Figure 6: Ray diagram of the Compact Camera Module where the rays are coloved by their
radial distance from the centroid on the image plane.
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Figure 7: Spot diagram for the Compact Camera Module. The spots bave been colored
according to their vadial distance from the center of the entrance pupil.

Reference

1. R.I. Mercado, 2015. Small form factor telephoto camera. US Patent 9 223 118 B2,
filed Oct. 31, 2013 and issued Dec. 29, 2015.

Application Library path: Ray_Optics_Module/Lenses_Cameras_and_Telescopes/
compact_camera_module
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Modeling Instructions

From the File menu, choose New.

NEW

In the New window, click Model Wizard.

MODEL WIZARD

o U1 A W

In the Model Wizard window, click 3D.

In the Select Physics tree, select Optics>Ray Optics>Geometrical Optics (gop). This model

will only consider a single physics ray trace.

Click Add.

Click Study.

In the Select Study tree, select Preset Studies for Selected Physics Interfaces>Ray Tracing.
Click Done.

GLOBAL DEFINITIONS

Parameters |

|
2

In the Model Builder window, under Global Definitions click Parameters 1.

In the Settings window for Parameters, type Parameters 1: Lens Prescriptionin
the Label text field. The prescription of the Compact Camera Module (see Table 1) will
be added when the geometry sequence is inserted in the following section.

Now, load the model definitions (Table 2) for the Compact Camera Module from a text
file.

Parameters 2

|
2

In the Home toolbar, click Parameters and choose Add>Parameters.

In the Settings window for Parameters, type Parameters 2: General in the Label text
field.

Locate the Parameters section. Click Load from File.

Browse to the model’s Application Libraries folder and double-click the file
compact_camera_module_parameters.txt.
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GEOMETRY |

Insert the prepared geometry sequence from file. You can read the instructions for creating
the geometry in Appendix — Geometry Instructions. Following insertion, the full set of
parameter definitions will be available in the Parameters node.

I In the Model Builder window, under Component | (compl) click Geometry 1.

2 In the Settings window for Geometry, type Compact Camera Module in the Label text
field.

3 Locate the Units section. From the Length unit list, choose mm.
4 In the Geometry toolbar, click Insert Sequence.

5 Browse to the model’s Application Libraries folder and double-click the file
compact_camera_module_geom_sequence.mph.

6 In the Geometry toolbar, click Build All.

7 Click the Orthographic Projection button in the Graphics toolbar. Orient the view to place
the optical axis (z-axis) horizontal and the y-axis vertical. Compare the resulting
geometry to Figure 2. The Cumulative Selections defining the aspheric surfaces and
obstructions can be seen in Figure 3 and Figure 5 respectively.

COMPONENT I (COMPI)

I In the Model Builder window, click Component | (compl).
2 In the Settings window for Component, locate the General section.

3 Find the Mesh frame coordinates subscction. From the Geometry shape order list, choose
Cubic. The ray tracing algorithm used by the Geometrical Optics interface computes the

refracted ray direction based on a discretized geometry via the underlying finite element

mesh. A cubic geometry shape order usually introduces less discretization error
compared to the default, which uses linear and quadratic polynomials.

DEFINITIONS
In the following, create a selection containing the surfaces in 3 of the 4 axially symmetric

quadrants of the camera. These will be used during postprocessing.

Box |

I In the Definitions toolbar, click Box.

2 In the Settings window for Box, locate the Geometric Entity Level section.
3 From the Level list, choosc Boundary.

4 Locate the Box Limits section. In the x maximum text field, type 0.

5 In the y minimum text field, type 0.
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6 Locate the Output Entities section. From the Include entity if list, choose
Entity inside box.

Complement |
I In the Definitions toolbar, click Complement.

In the Settings window for Complement, locate the Geometric Entity Level section.

2

3 From the Level list, choose Boundary.

4 Locate the Input Entities section. Under Selections to invert, click Add.
5

In the Add dialog box, in the Selections to invert list, choose Box I, All (Stop),
Exterior (IR Filter), and All (Image Plane).

6 Click OK.

MATERIALS

Now, define the lens materials. In this tutorial the three lens materials will be assigned a
refractive index appropriate for the chosen wavelength. However, the material refractive
indices could be defined as a function of wavelength (and temperature) using one of the
built-in optical dispersion models.

Material | (matl)
I In the Model Builder window, under Component | (compl) right-click Materials and
choose Blank Material.

2 Select Domains 3 and 4 only.
3 In the Settings window for Material, locate the Material Contents section.

4 In the table, enter the following settings:

Property Variable Value Unit Property group
Refractiveindex,real n_iso; nii = n_iso, nref1 | Refractive index
part nij =0

Material 2 (mat2)
I Right-click Materials and choose Blank Material.

2 Select Domains 2, 5, and 6 only.
3 In the Settings window for Material, locate the Material Contents section.

4 In the table, enter the following settings:

Property Variable Value Unit Property group
Refractiveindex,real n_iso; nii = n_iso, nref2 | Refractive index
part nij =0
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Material 3 (mat3)
I Right-click Materials and choose Blank Material.

2 Select Domain 1 only.
3 In the Settings window for Material, locate the Material Contents section.

4 In the table, enter the following settings:

Property Variable Value Unit Property group
Refractiveindex,real n_iso; nii = n_iso, nref3 | Refractive index
part nij =0

GEOMETRICAL OPTICS (GOP)
In the following sections the physics is defined.

I In the Model Builder window, under Component 1 (compl) click Geometrical Optics (gop).

2 In the Settings window for Geometrical Optics, locate the Ray Release and Propagation

section.

3 In the Maximum number of secondary rays text field, type 0. In this simulation stray light

is not being traced, so reflected rays will not be produced at the lens surfaces.

4 Select the Use geometry normals for ray-boundary interactions check box. In this
simulation, the geometry normals are used to apply the boundary conditions on all
refracting surfaces. This is appropriate for the highest accuracy ray traces in single-

physics simulations, where the geometry is not deformed.

5 Locate the Material Properties of Exterior and Unmeshed Domains scction. From the
Optical dispersion model list, choose Air, Edlen (1953). It is assumed that the lenses are

surrounded by air at room temperature.

Material Discontinuity |
I In the Model Builder window, under Component | (compl)>Geometrical Optics (gop) click
Material Discontinuity |I.

2 In the Settings window for Material Discontinuity, locate the Rays to Release section.
3 From the Release reflected rays list, choose Never.

Ray Properties |

I In the Model Builder window, click Ray Properties 1.

2 In the Settings window for Ray Properties, locate the Ray Properties section.

3 In the X text field, type lambda.
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Wall |
I In the Physics toolbar, click Boundaries and choose Wall.

2 In the Settings window for Wall, type Obstructions in the Label text field.

3 Locate the Boundary Selection section. From the Selection list, choose Obstructions.
4 Locate the Wall Condition section. From the Wall condition list, choose Disappear.
Wall 2

I In the Physics toolbar, click Boundaries and choose Wall.

2 In the Settings window for Wall, type Image Surface in the Label text field.

3 Locate the Boundary Selection section. From the Selection list, choose All (Image Plane).
Release from Grid |

I In the Physics toolbar, click Glebal and choose Release from Grid.

2 In the Settings window for Release from Grid, locate the Initial Coordinates section.
3 From the Grid type list, choose Hexapolar.

4 Specify the g, vector as

0 X
dz*tan(thetal) vy
dz

5 Specify the r, vector as
0 x

0y

1z
6 In the R, text field, type D_pupil/2.
7 In the N, text field, type N_ring.

8 Locate the Ray Direction Vector section. Specify the Ly vector as

0 X
tan(thetal) vy

1 z

Release from Grid 2
I Right-click Release from Grid | and choose Duplicate.

2 In the Settings window for Release from Grid, locate the Initial Coordinates section.
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3 Specity the q, vector as

0 X
dz*tan(theta2) vy

dz z

4 Locate the Ray Direction Vector section. Specify the Ly vector as

0 X
tan(theta2) vy

1 z

Release from Grid 3
I Right-click Release from Grid 2 and choose Duplicate.

2 In the Settings window for Release from Grid, locate the Initial Coordinates scction.

3 Specify the g, vector as

0 X
dz*tan(theta3) vy
dz

4 Locate the Ray Direction Vector section. Specify the Ly vector as

0 X
tan(theta3) vy

1 z

Release from Grid 4
I Right-click Release from Grid 3 and choosc Duplicate.

2 In the Settings window for Release from Grid, locate the Initial Coordinates section.

3 Specify the g, vector as

0 X
dz*tan(theta4) vy
dz z
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4 Locate the Ray Direction Vector section. Specify the Ly vector as

0 X
tan(theta4) vy

1 z

MESH |

Next, refine the mesh on the aspheric surfaces.

Free Triangular |
I In the Model Builder window, under Component | (compl) right-click Mesh I and choose

More Operations>Free Triangular.
2 In the Settings window for Free Triangular, locate the Boundary Selection section.
3 From the Selection list, choose Aspheric Surfaces.
Size |
I Right-click Free Triangular I and choose Size.
2 In the Settings window for Size, locate the Element Size section.
3 From the Predefined list, choose Extremely fine.
Free Tetrahedral |
I In the Model Builder window, right-click Mesh | and choose Free Tetrahedral.

2 Click Build All.

STUDY |

Step I: Ray Tracing

I In the Model Builder window, under Study I click Step I: Ray Tracing.

2 In the Settings window for Ray Tracing, locate the Study Settings section.
3 From the Time-step specification list, choose Specify maximum path length.
4 From the Length unit list, choose mm.
5

In the Lengths text field, type 0 10. The second path length is sufficiently long to ensure
that all rays make it to the image surface.

6 In the Home toolbar, click Compute.

I5 | COMPACT CAMERA MODULE


saleh
Highlight


RESULTS

In the following steps the(default ray diagram is adjusted to show different aspects of the
ray trace. First, define two cut planes which can be used to render the Compact Camera
Module cross-section.

Cut Plane |

I In the Results toolbar, click Cut Plane.

2 In the Settings window for Cut Plane, locate the Plane Data section.
3 From the Plane list, choose ZX-planes.

Cut Plane 2

In the Results toolbar, click Cut Plane.

Ray Trajectories (gop)

I In the Model Builder window, under Results click Ray Trajectories (gop).

2 In the Settings window for 3D Plot Group, type Ray Diagram 1 in the Label text field.

Ray Trajectories |
In the Model Builder window, expand the Results>Ray Diagram | node.

Color Expression |
I In the Model Builder window, expand the Ray Trajectories | node, then click

Color Expression |.

2 In the Settings window for Color Expression, locate the Expression section.

3 In the Expression text field, type gop.prf. This is the index of each of the release
features, starting at 1

Filter |

I In the Model Builder window, click Filter I.

2 In the Settings window for Filter, locate the Ray Selection section.

3 From the Rays to include list, choose Logical expression.

4 In the Logical expression for inclusion text field, type at (0,abs(x))<0.01[mm]. Only
the tangential rays will be rendered in this view.

Surface |

I In the Model Builder window, right-click Ray Diagram | and choose Surface.

2 In the Settings window for Surface, locate the Data section.

3 From the Dataset list, choose Cut Plane 2.

4 Locate the Expression section. In the Expression text field, type abs(y).
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Locate the Coloring and Style section. From the Coloring list, choose Gradient.
From the Top color list, choose Black.
From the Bottom color list, choose White.

Clear the Color legend check box.

NV O N o n

In the Ray Diagram | toolbar, click Plet. Orient the view to match Figure 1 to show only
the tangential rays.

Ray Diagram [.1

I Right-click Ray Diagram | and choose Duplicate.

2 In the Settings window for 3D Plot Group, type Ray Diagram 2 in the Label text field.
3 Locate the Plot Settings scction. From the View list, choose New view.

4 Locate the Color Legend section. Select the Show units check box.

5 In the Model Builder window, expand the Results>Ray Diagram 2 node.

Color Expression |

I In the Model Builder window, expand the Results>Ray Diagram 2>Ray Trajectories |

node, then click Color Expression 1.
2 In the Settings window for Color Expression, locate the Expression section.

3 In the Expression text field, type at('last',gop.rrel).This is the radial coordinate

relative to the centroid of each release feature at the image plane.
4 From the Unit list, choose pm.
Filter |
I In the Model Builder window, click Filter I.
2 In the Settings window for Filter, locate the Ray Selection section.
3 From the Rays to include list, choose All.
Surface 2

I In the Model Builder window, under Results>Ray Diagram 2 right-click Surface | and

choose Duplicate.
2 In the Settings window for Surface, locate the Data section.
3 From the Dataset list, choose Cut Plane 1.
4 Locate the Expression section. In the Expression text field, type abs(x).
Surface 3
I In the Model Builder window, right-click Ray Diagram 2 and choose Surface.

2 In the Settings window for Surface, locate the Coloring and Style section.
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3 From the Coloring list, choose Uniform.

4 From the Color list, choose Gray.

Selection |

I Right-click Surface 3 and choose Selection.

2 In the Settings window for Selection, locate the Selection section.

3 From the Selection list, choose Complement 1.

4 In the Ray Diagram 2 toolbar, click Plot. Orient the view to match Figure 6 to show the

all the rays.

2D Plot Group 3

In the following steps a spot diagram will be created to show the location of the rays in the
image plane.

I In the Home toolbar, click Add Plot Group and choose 2D Plot Group.

2 In the Settings window for 2D Plot Group, type Spot Diagram in the Label text field.

3 Locate the Color Legend scction. Select the Show units check box.

Spot Diagram |
In the Spot Diagram toolbar, click More Plots and choose Spot Diagram.

Color Expression |
I Right-click Spot Diagram | and choose Color Expression.
2 In the Settings window for Color Expression, locate the Expression section.

3 In the Expression text field, type at (0, gop.rrel). This is the radial coordinate relative

to the centroid at the entrance pupil for each ray release.
4 In the Spot Diagram toolbar, click Plot.

5 Click the Zoom Extents button in the Graphics toolbar. Compare the resulting image to
Figure 7.

Appendix — Geometry Instructions

From the File menu, choose New.

NEW

In the New window, click Model Wizard.

MODEL WIZARD
I In the Model Wizard window, click 3D.
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2 Click Done.

GEOMETRY |

I In the Model Builder window, under Component | (compl) click Geometry 1.

2 In the Settings window for Geometry, typec Compact Camera Module Geometry
Sequence in the Label text field.

3 Locate the Units section. From the Length unit list, choose mm.

GLOBAL DEFINITIONS

Parameters |

I In the Model Builder window, under Global Definitions click Parameters I.
2 In the Settings window for Parameters, locate the Parameters section.
3 Click Load from File.

4 Browse to the model’s Application Libraries folder and double-click the file

compact_camera_module_geom_sequence_parameters.txt.

PART LIBRARIES

I In the Home toolbar, click Windews and choose Part Libraries.

2 In the Model Builder window, under Component | (compl) click

Compact Camera Module Geometry Sequence.

3 In the Part Libraries window, sclect Ray Optics Module>3D>Apertures and Obstructions>
circular_planar_annulus in the tree.

4 Click Add to Geometry.

COMPACT CAMERA MODULE GEOMETRY SEQUENCE

Circular Planar Annulus | (pil)
I In the Model Builder window, under Component | (compl)>

Compact Camera Module Geometry Sequence click Circular Planar Annulus | (pil).
2 In the Settings window for Part Instance, type Stop in the Label text field.

3 Locate the Input Parameters section. In the table, enter the following settings:

Name Expression Value Description

do do_Ss 5 mm Diameter, outer

dl d1_S 2.505 mm Diameter, inner

nix nix 0 Local optical axis, x-component
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Name Expression Value Description

niy niy 0 Local optical axis, y-component

niz niz I Local optical axis, z-component

4 Click to expand the Boundary Selections section. In the table, enter the following

settings:

Name Keep Physics Contribute to

All N v None

5 Click New Cumulative Selection.

6 In the New Cumulative Selection dialog box, type Aspheric Surfaces in the Name text
field.

7 Click OK. This selection will be used to to refine the mesh on the aspheric surfaces.

8 In the Settings window for Part Instance, locate the Boundary Selections section.

9 Click New Cumulative Selection.

10 In the New Cumulative Selection dialog box, type Obstructions in the Name text field.

1l Click OK.

PART LIBRARIES

I In the Home toolbar, click Windews and choose Part Libraries.
2 In the Model Builder window, click Compact Camera Module Geometry Sequence.

3 In the Part Libraries window, sclect Ray Optics Module>3D>Aspheric Lenses>

aspheric_even_lens_3d in the tree.
4 Click Add to Geometry.

5 In the Select Part Variant dialog box, select Specify clear aperture diameter in the

Select part variant list.

6 Click OK.

COMPACT CAMERA MODULE GEOMETRY SEQUENCE

Aspheric Even Lens 3D | (pi2)
I In the Model Builder window, under Component | (compl)>
Compact Camera Module Geometry Sequence click Aspheric Even Lens 3D | (pi2).

2 In the Settings window for Part Instance, type Lens 1 in the Label text field.

3 Locate the Input Parameters section. Click Load from File.
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Browse to the model’s Application Libraries folder and double-click the file
compact_camera_module_geom_sequence_lens1.txt. These files are simplify the
mapping between the lens prescription and the input parameters for this part. Similar
files will be used for each of the four remaining lenses.

5 Locate the Boundary Selections section. In the table, enter the following settings:
Name Keep Physics Contribute to

Exterior v 3 None

Surface | \ Aspheric Surfaces

Surface 2 \/ Aspheric Surfaces

Edges \ Obstructions

Aspheric Even Lens 3D | (pi3)

|
2
3

In the Geometry toolbar, click Parts and choose Aspheric Even Lens 3D.
In the Settings window for Part Instance, type Lens 2 in the Label text field.
Locate the Input Parameters section. Click Load from File.

Browse to the model’s Application Libraries folder and double-click the file
compact_camera_module_geom_sequence_lens2.txt.

Locate the Position and Orientation of Output section. Find the
Coordinate system to match subsection. From the Take work plane from list, choose
Lens | (pi2).

6 From the Work plane list, choose Surface 2 vertex intersection (wp2).

7 Find the Displacement subscction. In the zw text field, type T_1.

8 Locate the Boundary Selections section. In the table, enter the following settings:
Name Keep Physics Contribute to

Exterior V \/ None

Surface | \ Aspheric Surfaces

Surface 2 \ Aspheric Surfaces

Edges V Obstructions

Aspheric Even Lens 3D | (pi4)

I In the Geometry toolbar, click Parts and choose Aspheric Even Lens 3D.

2 In the Settings window for Part Instance, type Lens 3 in the Label text field.

3 Locate the Input Parameters section. Click Load from File.
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Browse to the model’s Application Libraries folder and double-click the file
compact_camera_module_geom_sequence_lens3.txt.

Locate the Position and Orientation of Output section. Find the

Coordinate system to match subscction. From the Take work plane from list, choose
Lens 2 (pi3).

From the Work plane list, choose Surface 2 vertex intersection (wp2).

Find the Displacement subsection. In the zw text field, type T_2.

8 Locate the Boundary Selections section. In the table, enter the following settings:
Name Keep Physics Contribute to

Exterior v 3 None

Surface | \ Aspheric Surfaces

Surface 2 \/ Aspheric Surfaces

Edges \ Obstructions

Aspheric Even Lens 3D | (pi5)

|
2
3

In the Geometry toolbar, click Parts and choose Aspheric Even Lens 3D.
In the Settings window for Part Instance, type Lens 4 in the Label text field.
Locate the Input Parameters section. Click Load from File.

Browse to the model’s Application Libraries folder and double-click the file
compact_camera_module_geom_sequence_lens4.txt.

Locate the Position and Orientation of Output section. Find the

Coordinate system to match subsection. From the Take work plane from list, choose
Lens 3 (pi4).

From the Work plane list, choose Surface 2 vertex intersection (wp2).

Find the Displacement subsection. In the zw text field, type T_3.

8 Locate the Boundary Selections section. In the table, enter the following settings:
Name Keep Physics Contribute to

Exterior V \/ None

Surface | \ Aspheric Surfaces

Surface 2 \ Aspheric Surfaces

Edges V Obstructions

Aspheric Even Lens 3D | (pié)

I In the Geometry toolbar, click Parts and choose Aspheric Even Lens 3D.
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2 In the Settings window for Part Instance, type Lens 5 in the Label text field.
3 Locate the Input Parameters section. Click Load from File.

4 Browse to the model’s Application Libraries folder and double-click the file
compact_camera_module geom sequence_lens5.txt.

5 Locate the Position and Orientation of Output section. Find the
Coordinate system to match subsection. From the Take work plane from list, choose
Lens 4 (pi5).

6 From the Work plane list, choose Surface 2 vertex intersection (wp2).
7 Find the Displacement subsection. In the zw text field, type T_4.

8 Locate the Boundary Selections section. In the table, enter the following settings:

Name Keep Physics Contribute to
Exterior V V None

Surface | \/ Aspheric Surfaces
Surface 2 \ Aspheric Surfaces
Edges \/ Obstructions

PART LIBRARIES
I In the Geometry toolbar, click Parts and choose Part Libraries.
2 In the Model Builder window, click Compact Camera Module Geometry Sequence.

3 In the Part Libraries window, select Ray Optics Module>3D>Spherical Lenses>
spherical_lens_3d in the tree.

4 Click Add to Geometry.

5 In the Select Part Variant dialog box, select Specify clear aperture diameter in the
Select part variant list.

6 Click OK.

COMPACT CAMERA MODULE GEOMETRY SEQUENCE

Spherical Lens 3D | (pi7)
I In the Model Builder window, under Component | (compl)>

Compact Camera Module Geometry Sequence click Spherical Lens 3D | (pi7).

2 In the Settings window for Part Instance, type IR Filter in the Label text ficld.
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3 Locate the Input Parameters section. In the table, enter the following settings:

Name Expression Value Description

RI 0 Om Radius of curvature, surface | (+convex/
-concave)

R2 0 Om Radius of curvature, surface 2 (-convex/
+concave)

Tc Tc_F 0.21 mm Center thickness

do do_F 4.5 mm Diameter, outer

dl 0 Om Diameter, surface |

d2 0 Om Diameter, surface 2

dl_clear 0 Om Clear aperture diameter, surface |

d2_clear 0 Om Clear aperture diameter, surface 2

4 Locate the Position and Orientation of Output section. Find the
Coordinate system to match subscction. From the Take work plane from list, choose
Lens 5 (pi6).

5 From the Work plane list, choose Surface 2 vertex intersection (wp2).
6 Find the Displacement subsection. In the zw text field, type T_5.

7 Locate the Boundary Selections section. In the table, enter the following settings:

Name Keep Physics Contribute to
Exterior Y \ None
Edges \ Obstructions

Circular Planar Annulus | (pi8)
I In the Geometry toolbar, click Parts and choose Circular Planar Annulus.

2 In the Settings window for Part Instance, type Image Plane in the Label text ficld.

3 Locate the Input Parameters section. In the table, enter the following settings:

Name Expression Value Description
do do_I 5 mm Diameter, outer
dl 0 0Om Diameter, inner

4 Locate the Position and Orientation of Output section. Find the
Coordinate system to match subsection. From the Take work plane from list, choose
IR Filter (pi7).
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5 From the Work plane list, choose Surface 2 vertex intersection (wp2).
6 Find the Displacement subsection. In the zw text field, type T_6.

7 Locate the Boundary Selections section. In the table, enter the following settings:

Name Keep Physics Contribute to

All N v None

8 In the Geometry toolbar, click Build All.

9 Click the Orthographic Projection button in the Graphics toolbar. Orient the view to place
the optical axis (z-axis) horizontal and the y-axis vertical. Compare the resulting
geometry to Figure 2.

25 | COMPACT CAMERA MODULE



26 | COMPACT CAMERA MODULE



	Compact Camera Module
	Introduction
	Model Definition
	Results and Discussion
	Reference
	Modeling Instructions
	Appendix — Geometry Instructions



